E.Qual Premium
Point to point / Server
User Guide
For three-phase power quality analyzers
MAP 600 range
(English Version)
## Historic

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Modification</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/11/2009</td>
<td>1.7</td>
<td>- Complete pagination</td>
</tr>
<tr>
<td>25/06/2010</td>
<td>1.8</td>
<td>- Insertion of new screen shots</td>
</tr>
<tr>
<td>30/06/2011</td>
<td>1.9</td>
<td>- Fusion of E.Qual Premium and E.Qual Premium Server</td>
</tr>
</tbody>
</table>
Introduction

Congratulations to your choice of ENERDIS instruments and the E.Qual Premium software. We hope that it will help you in your professional power quality analysis.

ENERDIS has specially designed the MAP600 Series’ measuring instruments and the E.Qual Premium software to be user friendly and flexible to work with. The software can be used to make individual settings of each measuring instrument according to customer demands. The ENERDIS MAP600 Series measuring instruments are developed to fulfil class A according to the important norm IEC 61000-4-30. This will guarantee the user to have a reliable reference instrument whenever there are questions about the power quality.

In addition, all ENERDIS Power Quality measuring units can make internal report analysis according to national standards like the EN 50160 norm.

Good luck with your measurements!

Best regards

ENERDIS
# Table of contents

I. General information
   
II. Software installation
   
III. General information
   i. Login
   ii. Main window
   iii. Language settings
   
IV. Instrument configuration
   i. Communication
     1. Add measuring units
     2. Delete a unit
     3. Modify a unit
     4. Connect to a unit
     5. Configuring a unit
     6. Communication parameters
     7. Set the meter time
   ii. Real-time analysis
     1. Scope view + Phasor
     2. Harmonics and flicker
     3. Manuel transfer of data
     4. Partial downloads
   iii. Basic settings
   iv. Report settings
     1. Customized report
     2. Storage interval
   v. Sag / Swell
   vi. Transient settings (only for fast transient)
   vii. Event alarm settings
   viii. Callback
   ix. Digital outputs (option)
   
V. QualView - Measurement data analysis software
   i. Start of analysis
   ii. Navigation
     1. Loading a measurement file
     2. Redraw
     3. Unselect all
     4. Summary
     5. Graphical analysis function
     6. Copy, save and print
     7. Axis settings
     8. Zoom
     9. Simultaneous zoom
     10. Detailed information on samples
11. Insert a comment in a graph 31
12. Min/Max and Norm limit display 31

iii. Local event log 32
    1. Detailed information of event 33

iv. Disturbance analysis 34

v. Voltage and current analysis 35

vi. Harmonic analysis 36
    1. Individual harmonics 36

vii. Flicker analysis 37

viii. Unbalance analysis 38

ix. Power analysis 38
    1. Energy calculation 39

x. Frequency 39

xi. General inputs 40

VI. Generating the report 41
    i. Create reports 41
    ii. Generate a report 42

VII. Export 43
    i. Export to Excel 43
    ii. Export to PQDIF 43

VIII. E.Qual Premium Server 45
    i. CADac Monitor : Scheduler or script configurator 46
        1. Scheduler settings 46
        2. Creating and configuring a script 48
        3. Creating and configuring an equipment 48
        4. CADac log 49
        5. Maintenance 51
        6. Language 51
        7. Installing the license 51
        8. Option: E.Qual Email 51
    ii. Events/Statistics 52
        1. Basic functions 52
        2. Advanced functionalities 54
        3. Statistic viewer 55
        4. Device status 56
    iii. Long-time data 57
I. General information

The ENERDIS E.Qual-Premium software is made to be used together with the MAP600 series’ measurement instruments. The software is used for configuration, communication and real-time analysis plus graphical long time analysis including event viewers, graphical analysis windows and automatic report generators.

All of the MAP600 Series’ units are developed to measure voltage quality and disturbances in the electrical grid and can be permanently installed in delivery points and substations.

ENERDIS has designed them to fulfil class A according to the important IEC 61000-4-30 standard. Together with a unique price/performance relation this gives the utilities new possibilities to install high performance units at all levels of the electrical grid and even in the delivery points to the end customers. It will also give industrial customers an improved possibility to monitor the internal electrical grid down to each machine.

All of the MAP600 Series’ measuring units are developed according to the IMU concept (Intelligent Measurement Unit) which means that the units can perform intelligent analysis and calculate information direct in each unit before sending alarms to the central analysis system.

The IMU concept also contains the internal report analysis function according to national voltage quality norms. This minimizes the data amount that needs to be transferred from the measuring units to the central analysis system.

Figure 1 shows the different levels in the electrical distribution grid where the MAP600 Series’ measuring units can be installed.

MAP600 equipments are designed to be installed in delivery points and delivery substations so that they can measure power quality according to the standard. They are also designed to be placed electrical switchgears or tariff meter switchgear. It is important to remember that MAP600 equipments have to be placed in a clean and dry environment and the temperature must not vary too much.
II. Software installation

Before installing E.Qual Premium software, make sure that your computer operating system is Windows NT/2000/XP or later version. To be able to create reports, Microsoft Word 2000 or later version should be installed. If a different operating system is used the software may not work properly.

In order to install the analysis software, Qual-View, please follow the instructions below:

1. Insert the CD in the CD drive
2. Open Windows explorer and browse the CD
3. Run the file Setup.exe
4. Follow the instruction of installer

Once the installation is finished, the software will start in English as default. If you want to change the language, click on “Settings” → “Language”. Then change the language and restart the software so that the parameters are considered.
III. General information

E.Qual Premium is used for configuration of measuring units and for analysis of measurement data and is developed to be flexible and user-friendly. The basic functions of the software are described in this manual.

i. Login

When E.Qual Premium starts, a window appears for login as shown in Figure 2 below.

![Figure 2 - Login](image)

It is possible to login as Administrator or as User (read-only)

<table>
<thead>
<tr>
<th></th>
<th>Administrator</th>
<th>User (read-only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Admin</td>
<td>User</td>
</tr>
<tr>
<td>Password</td>
<td>Enerdis</td>
<td>User</td>
</tr>
</tbody>
</table>

ii. Main window

This is the first screen that shows after login. From this screen the three main functions configure, analyze and create reports are reached.

![Figure 3 - E.Qual Premium main window](image)
iii. Language settings

The ENERDIS E.Qual-Premium software has different language setting possibilities. Select the language in the “Settings” menu. After selecting a different language you need to restart the program for the changes to take effect.

Software automatically saves the last used language when we exit the software. The next session will be started with the new language.
IV. Instrument configuration

i. Communication

By clicking on the button “Configure”, you will open a new window.

“Communication” tab contains information on instruments and connections. If you are using the software for the first time, this list will be empty. Save instrument to be connected following the choice below.

![Figure 5 - Main window - ‘Communication’ tab](image)

**Information on Figure 5**

- **A.** The combo box shows information about saved equipments stored in the software
- **B.** This field shows information about the connection type, the serial number, etc.
- **C.** These icons will be explained in the following chapter (Add measuring units).
- **D.** The field ‘Communication status’ shows details of each connection made with the unit (disconnected, connected, etc.)
- **E.** These icons are used to save the unit configuration on the hard disk. Clicking on the button “Load Conf” will enable you to load a saved configuration file to use for another measuring unit.
1. Add measuring units

In order to connect to a measuring unit, we have to indicate its serial number, communication type, etc. By clicking on the button “Add”, a new window will be opened.

![Meter Info](image)

**Figure 6 - Information about the connection type and the meter**

Specify the product name (station number, customer name, etc.) and the serial number.

- **RS232 - Serial Port connection**
  When using direct connection from a computer to the unit, use a standard RS232 cable. Also remember to select in the connection type “Serial” and the correct COM port on your computer. Select also the speed.

- **Modem connection**
  If a modem should be used select in the connection type “Modem” and the Com port that should be used for the computer. Also remember to add the right telephone number in the field “Phone number” and to select the baud-rate.

Also remember to configure the MAP600 Series’ instrument with the right baud-rate settings for the modem port.

- **Ethernet connection**
  If Ethernet communication should be used select connection type “Ethernet” for units with external ethernet solution and “TCP Socket” for units with built-in Ethernet. Set the IP-address plus the IP port nr. In normal case the IP port nr should be set to 10001.

When all parameters are set, select “Save” to keep the communication settings. Each meter setting are saved in the list of “Saved meters”
2. **Delete a unit**

Click “Delete” button to remove measuring units from the stored list. In this case there is always a popup window asking if it should be really removed to avoid mistakes.

3. **Modify a unit**

All stored information about the measuring units can be changed by clicking on “Modify”. This alternative will open up the “Meter info” window to be changed.

4. **Connect to a unit**

To establish a connection to a unit, you will need to select a unit from the list “Saved meters” and press “Connect”. Units are added to this list by pressing the “Add” button and inserting communication settings for each unit.

![Connection settings](image)

**Figure 7 - Connection settings**

The field “Communication status” will show information regarding the connection.

If the communication is successful the software will automatically change to the window “Real-time values”. If the communication fails, check the “Communication status” field for information.

5. **Configuring a unit**

When all settings are chosen for the different windows in the configuration software you need to send it to the measurement instrument to be activated. This is done by clicking on the “Write configuration” button. This button is always grey if the software is not connected to a measurement instrument.

![Configuration of unit](image)

**Figure 8 - Configuration of unit**
6. Communication parameters

When connected to a measuring unit it is possible to change the communication settings as described below with Figure 9.

![Figure 9 – Communication settings](image)

**Information about Figure 9:**

A. Modem – We can set the desired speed for modem connection. If we use a GSM modem, then the speed must set at 9600 bps.

B. COM port – We can set here the speed for COM port. We advise you to set it at 57600 bps in order to avoid disturbances during the transfer.

C. CL port – Current Loop. This port is normally used with Enerdis CL adapter for multi drop communication. When activated without any active current loop, it can prevent all ports from communication.

D. IP settings – It is used only for units equipped with built-in Ethernet and not with external Ethernet gateway.

E. In order to set the time manually, just click on the button “Set meter time”. The time set will take the time of your computer.
7. Set the meter time

With E.Qual Premium, you can manually set the time. Remember this can effect the automatic time synchronisation if the unit is used in a central analysis system.

![Set meter time to computer system time](image)

Figure 10 - Button “Set meter time” and visualisation of time in “Real-Time values” tab

ii. Real-time analysis

“Real-time values” tab is automatically opened as soon as the connection with the unit is established. This window shows real-time value and information about recorded measurement.

![Configuration](image)

Figure 11 - “Real-time values” tab

**Information about Figure 11**

A. Real-time values are immediately displayed when the connection with the unit is established

B. Information about measurement data can be found here. We can see the memory occupation rate

C. These fields show quick information on disturbances recorded (sags/swells/transients)

D. “Chosen report” shows the norm for which the report will be edited. Moreover, the field “Report status” gives you an indication on the status of the last report (Passed or failed)
E. Use this button to print the real time values

F. This button enables you to open the harmonic spectrum and flicker

G. This button displays a scope view in real-time and the phasor

1. Scope view + Phasor

E.Qual Premium enables you to display in oscilloscope view (waveform) and phasor diagram at the same time for real-time analysis. You can access to this window by clicking on the button “Phases and Waveform” or in the phasor diagram itself.

When using the instrument, we can check and control if both voltage and current are connected in the right way.

The waveform viewer can be used to view voltage and current at the same time.

Information about Figure 12

Automatic scaling

Automatically set all scales within the oscilloscope and vector diagram.

Show sampling points

To be able to view each sample point in the waveform. It may be resampled to 32 points/cycle to minimize the data that is needed to be sent while using remote connection to the unit. The normal sampling rate for power quality calculations is 12.8 kHz (256 samples/cycle)
2. Harmonics and flicker

E.Qual Premium enables you to analyse in real-time harmonics and flicker. You can access to this window by clicking on the button “Harmonics and Flicker”.

You can choose the channel you would like to display for individual harmonics. It is possible to view individual harmonics up to the 50th rank for voltage and current.
3. Manuel transfer of data

In order to transfer manually the measurement file data from the unit to the hard disk, click on the button “Transfer data” in the tab “Real-time values”.

![Figure 14 - Transfer data](image)

Click on this button to begin the transfer will open up a new window so that you can choose which parameter you want to transfer. See Figure 15 below.

![Figure 15 - Download settings](image)
Before transferring the data, it is important to decide what kind of data you want to transfer. Below, the table indicates the different options:

| **Skip FROM and To time.** Download all data. | This alternative is available for all MAP600 Series’ instruments and excludes partial downloads. With this alternative the data that is transferred is minimized and **always includes:**
| **Event data**
| **Waveform data (deviations/events)**
| **Report data (norm EN 50 160 etc)** |
| **Transfer avg/min/max** | With this alternative **all calculated average, min and max-values** (except from individual harmonics) will be transferred. (normal 1/10 min values depending on chosen storage intervals) |
| **Transfer ind. harmonics** | **All data including individual harmonics** will be transferred. |
| **Transfer frequencies** | **All data including frequencies** will be transferred |

Choose one of the different options and then click on the button “Download”. A new window will be opened to save the file in the hard disk. The extension of file is either .mpq or .mpq2.

![Browse window](image)

**Figure 16 - Browse window**

In order to analyse a measurement file, you can click on the button “Analyse” directly from the main window of E.Qual Premium. The analysis software includes the analysis with an event log, the graphical views and a report generator. After clicking on “Download”, you can see the state of this download on the status bar, as shown below.

![Status bar of transfer](image)

**Figure 17 - Status bar of transfer**

4. Partial downloads

Some MAP600 Series’ instruments support partial download. It enables the user to define a specific start and end date for each instrument. We choose a shorter period of time in order to reduce the quantity amount of downloaded data, especially in case of modem communication.
The partial download can be activated by unchecking the box “Skip FROM and TO time. Download all data”. Then, we can choose the period to download, as shown in Figure 18 below.

![Figure 18 - Partial download](image)

Choose the start and end date/time.

![Figure 19 - Select the start and end date/time](image)

The partial download function can be used for all levels of data according to the other transfer settings.
iii. Basic settings

In order to be as user-friendly as possible, E.Qual Premium enables you to configure basic settings for quick use. For advanced settings, you will have to set parameters in the remaining other tabs.

“Basic settings” tab contains parameters you need to configure the instrument. For example: Nominal or declared voltage, product name, PT & CT ratio.

![Figure 20 - Basic settings](image)

Information about Figure 20

A. Write in the name of your instrument (substation, customer, etc.). This name is internally stored in the instrument and will be used for analysing the measurement files.

B. In the Configuration combo box, choose the wiring configuration if the instrument is measuring single phase, 4 wires Ph-N, 3 wires Ph-Ph, etc.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 W Phase-Neutral</td>
<td>Measurement of phase-neutral voltages</td>
</tr>
<tr>
<td>3 W Phase-Phase</td>
<td>Measurement of phase-phase voltages</td>
</tr>
<tr>
<td>1 W Phase-Neutral</td>
<td>Measurement of one phase voltage</td>
</tr>
<tr>
<td>3 W Phase-Phase, 2 Currents</td>
<td>Measurement of phase-phase voltages and two currents, calculating third current</td>
</tr>
</tbody>
</table>

Caution: No matter what configuration you choose, the connection of instrument remains the same

C. Specify the nominal or the declared voltage. If using a voltage transformer (PT or VT), always specify the primary voltage.

D. If using measuring transformers (PT/CT) for measurements on MV and HV it is possible to set the constants to calculate the primary values. The constant is the ratio of the measuring transformers primary and secondary side.

E. Tick this box if the measuring instrument should use the flagging concept according to the IEC 61000-4-30 standard.
F. Tick this box if the measuring instrument should measure voltage steps and save them as events

G. Specify the storage interval for power measurement and general inputs

iv. Report settings

If choosing an existing report model according to the standard, all parameters of measured/calculated values will be automatically set. All MAP600 Series’ measuring units build internally the report according to the standard. There is no need to format the file; E QUAL Premium will make it for you. Thanks to this feature, the amount of data sent will be as less as possible and the user will be accessing quickly to detailed statistic disturbances.

Preset of internal report

<table>
<thead>
<tr>
<th>EN 50160 LV</th>
<th>Low voltage (230 V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN 50 160 MV</td>
<td>Medium voltage (≤ 35 kV)</td>
</tr>
</tbody>
</table>

Furthermore, the user can customize own report with a flexibilty on setting the parameter.

1. Customized report

In order to create a customized report, choose in the configuration combo box “Custom settings”. Then, it is possible to give a custom name for the report and you can edit all parameters.

![Figure 21 - combo box for writing the customized report name](image1)

![Figure 22 - Custom settings of parameters](image2)
By clicking on “Save report configuration”, the customized report will be saved in the hard disk and all generated report will be saved with this report name. Deleting a customized report is available by clicking on the button “Delete report”.

2. Storage interval

When a standard report is selected, the storage interval of parameters is automatically filled according to the standard. When a customized report is selected, then the user can specify custom parameters for storage interval.

![Figure 23 - Storage interval for long-time data (a) and report limits (b)](image)

Note that the shortest interval for data recording concerning the internal is one minute. It does not concern frequency and signal voltages. Short interval time is not recommended because the measurement unit cannot record rapid disturbances except via the triggering level functions which do not depend on the report thresholds.
v. Sag / Swell

MAP600 measurement unit can be configured with individual parameters for sags/swells events surveillance.

Information about Figure 24

A. Set the percentage value (% of nominal) for the triggering of sag or swell events. Note that it is possible to set different values for sag or swell events.

B. Pre-trig is the time that will be recorded before the trig point (seconds). Post-trig is the time that will be recorded after the trig point (seconds). The maximum total of recording time for sag/swell event must not exceed 10 seconds: (Post-trig + Pre-trig) ≤ 10s.

C. Hysteresis is the difference in magnitude between the start and end thresholds of a sag/swell event. The typical value is set to 2% of \( U_{\text{din}} \) (declared input voltage)

D. Sliding reference: the measurement unit does not trig for sag/swell depending on the nominal voltage but on an average of the voltage value in a specified interval time (1 min as described in the IEC 61000-4-30). This alternative is recommended for MV or HV installations where \( U_{\text{nom}} \) is often said \( U_{\text{dec}} \) or \( U_{\text{din}} \) is varying. For LV installation, \( U_{\text{nom}} \) is normally fixed (230V) implying that using sliding reference is not recommended

E. Activate the box “Waveform recording” to record waveform at the same time as ½ cycles RMS values if sag/swell limits are passed. A lower sampling frequency for waveform will use less memory and fasten the data transmission

F. Using the “Recalculated sampling frequency” will enable you to lower the sampling frequency of sag/swell waveform recording. This is used to save memory. The maximum sampling rate is 12800 Hz.

G. Choose the pre-trig and post-trig for sag/swell waveform recording. A maximum of 20 periods can recorded for each event.

H. By selecting this option, you enable measuring and trigerring on zero sequence. Then choose the trigger value for event recording.
I. Enabling measuring enables you to measure the voltage on the 4th channel. Note this alternative only exists for MAP600 instrument where channel A4 is used for measuring the neutral voltage.

vi. Transient settings (only for fast transient)

MAP640 measures fast transient. Use the tab “Transients” tab to set the limits for these events.

![Figure 25 - Transients settings](image)

In this tab, you can set the value for triggering. It is possible to set different values for the negative and positive transient limits.

As for sag/swell events, you can set the pre-trig and the post-trig for waveform recording. The total maximum period is 10 periods. The maximum sampling frequency is 12800 Hz.

vii. Event alarm settings

The MAP600 Series’ measuring instruments can use specific event alarms for different parameters that will not affect the report settings. The triggering will be based on each selected parameter and with the storage intervals that is set in the “Report settings” window.

![Figure 26 - Transients settings](image)

Every time a limit is passed according to the settings the measurement instrument will record a start and an end event. The start event will show the time when the limit is exceeded. The end event will store information
about the end time of the event (when it goes back within the limit) and also the highest value that have been during the event.

The idea of the event alarms is to be able to follow smaller variations in the power quality than the norm will cover. It can also be used for statistical purpose since it will store all event information.

viii. Callback

All of the standard MAP600 Series’ instruments also support callback functions to be able to send SMS-alarm for different disturbances (Provided that a GSM modem is connected to the Modem port of MAP)

![Callback settings window](Image)

**Figure 27 - Callback settings window**

It is possible to activate the SMS-alarm function and to select a phone number where the SMS-alarm should be sent. It is also possible to set different events that should start the SMS-alarm.

Possible SMS-alarm parameters

<table>
<thead>
<tr>
<th>Event Type</th>
<th>SMS Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report deviation</td>
<td>Sends an SMS alarm if the internal report analysis is failed</td>
</tr>
<tr>
<td>Short interruption</td>
<td>Sends an SMS for all short interruptions</td>
</tr>
<tr>
<td>Long interruption</td>
<td>Sends an SMS for all long interruptions</td>
</tr>
<tr>
<td>Sag</td>
<td>Sends an SMS for all sag events</td>
</tr>
<tr>
<td>Swell</td>
<td>Sends an SMS for all swell events</td>
</tr>
<tr>
<td>Transients</td>
<td>Sends an SMS for all transient events</td>
</tr>
<tr>
<td>Event alarm</td>
<td>Sends an SMS for all alarm events</td>
</tr>
</tbody>
</table>

ix. Digital outputs (option)

MAP600 series are equipped with 2 digital outputs in order to send information to a SCADA for example. This option is activated through a license and adds a new tab in the configuration window.

In order to activate the trigger on digital output, you only have to tick the box “Enable digital trigging”. For each binary output, you can choose which information you want to send to the SCADA.

Furthermore, these outputs can be set as pulse output.
V. QualView - Measurement data analysis software

In the main menu, you can find a button “Analyze”. By clicking on this button, you will launch the analysis software QualView. The measurement files are stored with the extension .mpq or .mpq2.

i. Start of analysis

When QualView starts, a browsing window appears. It enables you to choose the data measurement file you want to analyze.

![Figure 28 - Browsing the file](image)

After loading the data, information window will appear (Figure 29). In this window, you can find information concerning the data you have loaded and also a summary of reports and events.

![Figure 29 - Fenêtre résumé / Information sur le fichier de mesure](image)
In the main window, you find the measured parameters in the different tab. These tabs change depending on the MAP equipment you are using.

In the Figure 30, the main window shows measurement file generated with MAP607. The MAP607 is the single phase power quality analyzer. It measures the Phase/Neutral and the Phase-Neutral/Ground. The Figure 31 shows the main window from a file generated with MAP610/MAP620/MAP640.
ii. **Navigation**

1. **Loading a measurement file**

To load a measurement file, click on the button “Load data” located in the left-hand corner, Figure 32. In the browse window, choose the file you want to open. Measurement file ends with .mpq or .mpq2.

![Figure 32 - Load data](image)

2. **Redraw**

Each time you select a new parameter, the viewer needs to be redrawn by clicking on the “Redraw” button.

![Figure 33 - Redraw, Unselect all](image)

3. **Unselect all**

The “Unselect all” button, Figure 33, is used when you want to cancel all ticked parameter in all the tabs. By clicking on “Redraw” you will get an empty graph area.

4. **Summary**

The “Summary” button enables you to open the same window as Figure 29.
5. **Graphical analysis function**

QualView is a tool for graphical data analysis. The software contains different tools for an easy analysis. Right click on the graph will enable you to access a list of graphical tool. The list is shown in Figure 34.

The different functions are explained later.

![Figure 34 - Drawing function](image)

6. **Copy, save and print**

Right click on the graph will enable to copy, save or print the picture. By copying in the clipboard, you can use it in your report.

If you save the picture, you have to specify the format. The jpg format is recommended.

7. **Axis settings**

By default, the configuration of axis is set to automatic scale. If you want to set manually the axis, then click on the option “Axis settings” and untick the box “Auto scale”. Click on “Redraw” button.

![Figure 35 - Axis settings](image)

To return back to “Auto scale” just select back this option in the axis settings window.
8. Zoom

In the graphs, it is possible to zoom in or zoom out in order to have a better measurement period of analysis. By remaining in the left click of the mouse, you can define a zone for zooming.

![Figure 36 - Zoom In](image)

When the zoom is activated, it is possible to scroll the graph in X-axis or Y-axis with the Shift button and the mouse left button. By clicking on the mouse left button, the cursor will change in hand cursor.

To come back to the initial graph, right click and select « Un-zoom » or “Undo all zoom/pan”.

9. Simultaneous zoom

In QualView, it is possible to visualize at the same time several graphs from different measured values. By activating “Simultaneous zooming”, a zoom on one graph will automatically the same zoom on the other graphs.

![Figure 37 - Simultaneous zoom on several graphs](image)
10. Detailed information on samples

In the graph, by right click, you can select the option “Show values”. This option enables you to visualize the samples with the mouse. A tooltip will appear with the date/time and the value of sample.

![Figure 38 - Detailed information on samples](image)

11. Insert a comment in a graph

In order to insert a comment in a graph, right click on the graph and select “Add/Edit comment”. The comment is limited in character. Then you have to save the comment by choosing the file.

![Figure 39 - How to insert a comment](image)

12. Min/Max and Norm limit display

By selecting “Show min/max lines” and “Show norm limits” (Figure 40), the lines will appear on the graph. By this way, it is possible to see if the voltage is out of the standard.
Update the graph by clicking on the button “Redraw”.

iii. Local event log

In the menu “Events/Reports”, it is possible to navigate into the different events. It is also possible to display a local event log or the local report log by clicking on one of the two buttons. The local event list enables you to display all events from the downloaded file (see Figure 41 below).

An incorporated filter on each column enables you to study some event types or to sort by type. By clicking on the event, the graph will be automatically updated.
In the Figure 42, we sorted the event according to their type. The list contains information on the date/time, the measurement site, the event type, the values, graph or data.

Events where the column “Data/Graph” indicates “Yes” are associated with graphical data stored in the file. This graphic can be studied in the tab “Events/Reports”.

1. **Detailed information of event**

The Figure 43 shows information concerning a selected event. The detailed information is displayed under the list.
iv. Disturbance analysis

In the tab “Events/Reports”, you can analyze the disturbances recorded by the equipment. Below, you find a graph of sag recorded by a MAP620.

**Figure 44 - “Events/Reports tab**

**Explanation of Figure 44**

A. Choose which channel you want to display. You can change the colour by clicking on the color box.

B. For sag/swell event, it possible to display the waveform and the RMS signature. The waveform is displayed if you have configured the MAP to record the waveform in sag/swell event with the sample rate. For transient, the waveform is only recorded. By default, the box Auto is selected.

C. You have detailed information of event (date/time, disturbance type, the number of the event). Only graphical data are displayed. For data which do not have a graphical, you can find detailed information in the event list.

D. Click on the button Previous or Next to go through the event (graphical data only)
v. Voltage and current analysis

The analysis window contains a tab for long-time data. It is located in the tab “Voltage/Current”. This tab contains average/min/max values of each channel.

The min/max values are respectively the minimum and the maximum values of RMS ½ cycles for each recorded interval (i.e 1 min or 10 min)

Always use the button “Redraw” to update the graph after changing a parameter.
vi. Harmonic analysis

The tab “Harmonics” shows measured values for harmonics in THD or individual harmonics.

Choose the channel you want to display and then click on the button “Redraw”.

1. Individual harmonics

In order to analyze individual harmonics, you only need to click on the button “Individual harmonics”. A new window will appear.
Select the individual harmonics you want to display by ticking the boxes as indicated Figure 48. You can select a group of harmonics.

When selecting THD and individual harmonics, the display window will automatically split in 2 parts.

vii. Flicker analysis

Flicker can be analyzed in the tab “Flicker”. You can display the Pst (10 min) values or Plt (2h) values.
viii. Unbalance analysis

Unbalance can be analyzed in the tab “Unbalance”. The voltage unbalance, in %, is the result of the ratio between the negative sequence and the positive sequence. Some MAP instruments can measure the ratio between the zero sequence and the positive sequence.

![Figure 51 - Unbalance analysis](image)

ix. Power analysis

In the tab “Power”, you can find the analysis for active power, reactive power and apparent power. There is also the possibility to display the displacement factor and power factor.

![Figure 52 – “Power” tab](image)
1. Energy calculation

In the “Power” tab, you can find a button for calculating the energy. We can visualize the active and reactive energy for the period of download and the average value for the last 24H.

![Energy Calculation](image)

**Figure 53** - Energy

x. Frequency

The tab “Frequency” is used to analyze the frequency in long-time data. As the period of integration, the measurement of frequency will increase the memory storage.

![Frequency Analysis](image)

**Figure 54** - Frequency analysis
xi. **General inputs**

![Figure 55 - General inputs analysis](image)

The tab “General Inputs” is used to analyze data from MAP equipped with general inputs. You can analyse data like temperature, pressure, speed, etc. In order to use these inputs, the signal must be 0-20 mA.
VI. Generating the report

E.Qual Premium contains a functionality to create report in compliance with the standard you have chosen, like EN 50160 for example or others. As default, the MAP instruments automatically generate a weekly report. Once the report is ready, the LED from the equipment displays if the last report is accepted or failed. MAP instruments have the great advantage to create a built-in report.

i. Create reports

It is easy to create report according to standards. E.Qual Premium integrates report model in MS-Word format.

To create a report, click on the button “Create report”

![Create report](image1)

**Figure 56 - Create report**

A browsing window appears, as shown below, where the user can choose the measurement file for the report.

![Browsing window](image2)

**Figure 57 - Browsing window**
When done, the measurement file is analyzed regarding the information inside. A new window appears with a list of report and the date. Furthermore, there is the status of the report.

ii. Generate a report

Choose the report you want to generate. Then double-click to generate it. It will compute all data for the chosen week. A mention “Generating report” will be displayed and then automatically opens MS-Word.

From this point, the user can customize the report.

The weekly report contain a summary of the analysis for the chosen period (accepted/failed on each parameter) and detailed information on each parameter (min/max values for the chosen week) and what are the standard limits, etc. It is a base for litigation on power quality.

It is also possible to generate the report from the analysis software Qual-View. You only have to click on the button “Report log” and double-click on the report to generate it.
VII. Export

E.Qual Premium enables you to export .mpq measurement data in MS-Excel® or in PQDIF (option).

i. Export to Excel

Measurement data file can be exported in Excel by selecting “Export” → “To Excel” in E.Qual Premium main window.

![Figure 60 - Exporting data in Excel](image)

Choose “To Excel” to open a browsing window where you can choose the measurement data.

![Figure 61 - Browsing window to choose the measurement to export](image)

The exported file is always saved in the same folder as the original file.

ii. Export to PQDIF

E.Qual Premium enables you to export measurement data file in PQDIF format (Power Quality Data Interchange Format). This conversion is activated through a license.

![Figure 62 - Exporting data in PQDIF](image)

Select “To PQDIF” to start the export. Like the Excel export, a browsing window appears and you can select the file you want to export.
Once the file is chosen and specified the name of the new file, the export will start.

Then, a pop-up window appears indicating the elapsed time for the export task.

PQDIF is a global power quality data used by many types of software. For more information, please contact ENERDIS.
VIII. E.Qual Premium Server

So that E.Qual Premium could perform the data-retrieval, it is important to disconnect the point-to-point communication. Indeed, in point-to-point connection, the communication port is occupied. In the server configuration, the point-to-point connection will enable you to configure the equipment or to visualize in real-time the values (between two data-retrievals).

The system E.Qual Premium contains:

- **E.Qual Premium** with a license to activate the server side application
- **CADac Multiple Port**: Architecture for multi-site/multi-equipments support
- **CADac Monitor**: Data-retrieval engine configurator/scheduler
- **MetDab2**: Database (DB) in Microsoft SQL Server¹ format

It is supposed that the connection to the database is valid².

The type of architecture for a site with several equipments can be as shown below:

In E.Qual Premium Server, the license activates 3 additional buttons which enable you to configure the scheduler (“System Administration”) and to visualize the events and statistical view (“Events/Statistics”) or long-time data (“Long-time data”).

¹ The database MetDab2 is included in the E.Qual Premium Server package. Microsoft SQL Server® is not included.
² When installing the software, the database instance name must be specified in order to install the database MetDab2. The instance name corresponds to the name of the database and it is indicated in the login connection via SQL Server Management Studio.
i. CADac Monitor: Scheduler or script configurator

CADac Monitor is executed from E.Qual Premium by clicking on the button “System Administration”.

### Figure 68 - Start of CADac Monitor

**Explication of Figure 68**

A. Configured power quality meters (targetted or not) according to the communication type

B. Scripts of data-retrieval configuration

C. Information on the equipment (configuration) or details on the chosen scripts

1. **Scheduler settings**

When the scheduler is started, it is important to specify the path for the database. Generally, this information is requested and fixed while installing the software. To access to this setting, click on Tools ➔ CADac Connections and Settings.
The setting window enables you to configure several parameters:

- **General** → This tab contains the configuration of interval time and number of simultaneous scripts
- **Log** → This tab enables you to specify the verbosity of error and trace log. You can also define the path for downloaded measurement file
- **Storage** → this tab enables you to choose events you do not want to store in the database
- **Communication** → This tab enables you to specify the path of database (instance name) and CADac IP

It is important to include the correct parameters for database IP and for the scheduler.

If the state bar of CADac appears in red “CADac not running”, then the scheduler is not launched. By pressing the button play (▶), you can manually launch CADac and the state bar will change to green “CADac running”).

**IMPORTANT:** In order to stop the data retrieval engine, it is preferable to use the button “Stop gently”. It guarantees you that all remaining running jobs will end in right way before the full stop of CADac Monitor. The normal stop (■) will imply an instant stop with a risk to have jobs not finished.
2. Creating and configuring a script

Once you have configured all parameters for database connections, you can now create data-retrieval scripts. By default, the script All Data is already configured. Follow the steps below, to create a script:

By clicking on the button indicated as 1, a new line will appear in the window Schemas to create a new script. You can name the script, select the collect period (either you use the list box or you can manually set the periodicity, minimum 1 min). Then, in 3, you can check the values you want to store in the database.

Note that for each script created automatically implies events retrieval. Furthermore, selecting Energy will automatically inhibit the other data. For each script, you can also choose to erase the events and synchronize the unit time with the computer time.

Once the script configuration is finished, just click the button “Submit to DB” in order to save the changes.

N.B: One script can be allocated to several equipments

3. Creating and configuring an equipment

Once you saved the scripts, you can add the equipments you have in your network. Then, you will configure which script you want to add to the equipment.
In order to create equipment, you have to click on the button 1. In the info-box 2, you have to indicate information about the meter (serial number, name, type of connection, location, etc.). For the type of equipment, if you possess a MAP Compact, please select the equipment Metrum® SC. If you possess a MAP6XX model, click on Other.

To add a script to the equipment, right click on the selected equipment and select the saved script.

Then save the changes by clicking on the button “Submit to DB”

4. CADac log

CADac Monitor enables you to check the steps performed by the data-retrieval engine. By clicking on “Tools” → “CADac log”. A new window will appear with main actions on the right window.
On the left side, you will find all equipments connected on your network with the last message. On the right side, you fond a general log. Depending on the verbosity, the log will display more or less information.

If you click on the last message of the equipment, it will automatically display a new window with more detailed information on the selected equipment.
The default path for the logs is \Program Files\CA Enerdis\CADac Multiple Port\log (if you did not change the path when configuring the CADac Monitor)

5. Maintenance

By clicking on the button “Tools” → “Maintenance”, you can delete all measurement files and/or log files stored in your hardisk or manually store mpq file in the database (like MAP607 files for example)

![Figure 74 - Maintenance window](image)

6. Language

By clicking on “Tools” → “Language”, you can select the default language for the software. Once you select the language, you have to restart the application for the changes to be occurred.

**NOTE:** Closing the application will not stop the data-retrieval engine. It will still run as background job. Stopping the service can be performed in “CADac connection and settings”.

7. Installing the license

By clicking on “Tools” → “Install license”, you can install additional licenses such as E.Qual Email which enables you to send automatic e-mails to defined users in case of events.

8. Option: E.Qual Email

The activation license of E.Qual Email adds a new menu in CADac Monitor “Tools”.

![Figure 75 - E.Qual Email](image)
When you click on “Event Notifications (e-mail)”, a new window will appear to configure the recipients, the events for each recipient and the configuration of the SMTP server.

![E.Qual Email configuration window](image)

**Figure 76 - E.Qual Email configuration window**

### ii. Events/Statistics

In the main window of E.Qual Premium, you can find the button “Events/Statistics”. By clicking on this button, a new window will appear with event log.

#### 1. Basic functions

![Evènements/Statistiques](image)

**Figure 77 - Evènements/Statistiques**
This window contains several fields:

1. List of all equipments or selected equipment (found in the database)
2. Event log for all equipments or selected equipment
3. Event impact in time scale
4. Connection status log on the database
5. Database parameter (instance name or IP) and selection of the period

After each modification, just on the button “Update”

Choosing an event will appear in red in the window 3.

![Figure 78 - Event log + Impact graph](image)
By double clicking on the event, Qual-View will be automatically opened and display the waveform/signature of the event.

2. Advanced functionalities

By right clicking on the event log, you can access to different menus.
This menu will enable to choose:

- **Update**: Event update list
- **Event type filter**: Filter on the events you want to display or not
- **Statistics viewer**: UNIPEDE, ITIC and SEMI F47 event statistical viewer
- **Generate report**: Enables you to generate the report (click on the report)
- **View event**: Enables you to visualize event
- **Export events to CSV file (Excel)**: Enables you to export the event list to table in CSV file format
- **Print**

3. **Statistic viewer**

The right click on the event log enables you to select the statistics viewer. The viewer displays graphs depending on the type:

- **ITIC**: Template displaying the event impact depending on time and percentage of nominal voltage (Green zone means you are in the template)
- **UNIPEDE**: Barchart classifying sags/dips depending on the time depth and percentage of nominal voltage.
- **SEMI F47**: Template displaying the event impacts depending on time and percentage of nominal value. (Event in the red zone means the event impact is not good)

Below, you find figures with different statistic view:
4. Device status

The tab “Device status” displays information about all equipments connected to the network. Information such as device serial number, name, setting and data-retrieval job are displayed.

Each line in the window can be in different colors depending on the communication state, according to the table below:
The periodicity of data-retrieval has been set to "Never". It indicates that the service will never connect or transfer data from this device.

The last data-retrieval is successful

The last data-retrieval has failed

iii. Long-time data

By clicking on the button "Long-time data", a new window will appear. This window enables you to analyze data recorded for long time period.

![Figure 84 - Device status](image)

![Figure 85 - Long-time data](image)
This window is empty. In order to display the equipments, just select the date period you want to analyze (start date and end date) and click on the button “Update from DB”.

It will display like this:

```
Figure 86 - Mise à jour des équipements
```

On the equipments where you see the symbol “+”, you can have the choice on the parameters you would like to visualize. Then, drag and drop this parameter in the next empty window. In the example, we chose U1 RMS.

```
Figure 87 - Drag the parameter
```
Then, you have to click on the button “Redraw” to display the trend.

You can also display more parameters in the same window (simultaneous analysis). You just have to proceed like previously.
You can also display a group of parameters. Here, we chose the group “Voltage RMS/Min/Max, U1-U4”. We do the same as before.

Click on “Redraw” and the trend will be displayed.
A right click on the graph will enable you to display the graphical options (the same as in Qual-View) → Simultaneous zooming, Show points values, etc.

Un clic droit sur le graphe vous permet d’afficher des options graphiques (idem menu graphique que Qual-View) → Simultaneous zooming, Show points values, etc.
Table des illustrations

Figure 1 - Level of electrical distribution grid ................................................................. 6
Figure 2 - Login .................................................................................................................. 8
Figure 3 - E.Qual Premium main window ........................................................................ 8
Figure 4 - Language settings ............................................................................................ 9
Figure 5 - Main window - ‘Communication’ tab ............................................................... 10
Figure 6 - Information about the connection type and the meter ........................................ 11
Figure 7 - Connection settings .......................................................................................... 12
Figure 8 - Configuration of unit ....................................................................................... 12
Figure 9 – Communication settings .................................................................................. 13
Figure 10 - Button “Set meter time” and visualisation of time in “Real-Time values” tab .... 14
Figure 11 - “Real-time values” tab ................................................................................... 14
Figure 12 - Waveform and phasor diagram ..................................................................... 15
Figure 13 - Real-time analysis harmonics in graph (a) and table (b) and flicker ............... 16
Figure 14 - Transfer data .................................................................................................. 17
Figure 15 - Download settings .......................................................................................... 17
Figure 16 - Browse window ............................................................................................... 18
Figure 17 - Status bar of transfer ...................................................................................... 18
Figure 18 - Partial download .............................................................................................. 19
Figure 19 - Select the start and end date/time ................................................................... 19
Figure 20 - Basic settings .................................................................................................. 20
Figure 21 - combo box for writing the customized report name ......................................... 21
Figure 22 - Custom settings of parameters ........................................................................ 21
Figure 23 - Storage interval for long-time data (a) and report limits (b) ......................... 22
Figure 24 - Sag/Swell settings ........................................................................................... 23
Figure 25 - Transients settings .......................................................................................... 24
Figure 26 - Transients settings .......................................................................................... 24
Figure 27 - Callback settings window ................................................................................ 25
Figure 28 - Browsing the file ............................................................................................. 26
Figure 29 - Fenêtre résumé / Information sur le fichier de mesure ..................................... 26
Figure 30 - Main window with MAP607 file .................................................................... 27
Figure 31 - Main window with 610/MAP620/640 file ......................................................... 27
Figure 32 - Load data ......................................................................................................... 28
Figure 33 - Redraw, Unselect all ....................................................................................... 28
Figure 34 - Drawing function ............................................................................................ 29
Figure 35 - Axis settings .................................................................................................... 29
Figure 36 - Zoom In ............................................................................................................ 30
Figure 37 - Simultaneous zoom on several graphs .............................................................. 30
Figure 38 - Detailed information on samples ................................................................... 31
Figure 39 - How to insert a comment ............................................................................... 31
Figure 40 - Limits min/max and norms .......................................................................... 32
Figure 41 - Event list .......................................................................................................... 32
Figure 42 - Event list with a sort of event type ................................................................. 33
Figure 43 - Detailed information of event ......................................................................... 33
Figure 44 - ”Events/Reports tab ..................................................................................... 34
Figure 45 - Recorded sag (waveform) .............................................................................. 35
Figure 46 - Voltage/Current analysis ............................................................................... 35
Figure 47 - Harmonics analysis ........................................................................................ 36
Figure 48 - Choice of individual harmonics to display ...................................................... 36
Figure 49 - Simultaneous display of THD and indivual harmonics .................................. 37
Figure 50 - Flicker analysis (Pst & Plt) .............................................................................. 37
Figure 51 - Unbalance analysis .......................................................................................... 38
Figure 52 – “Power” tab ..................................................................................................... 38
Figure 53 - Energy ............................................................................................................. 39
Figure 54 - Frequency analysis ......................................................................................... 39
Figure 55 - General inputs analysis .................................................................................. 40
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>56</td>
<td>Create report</td>
<td>41</td>
</tr>
<tr>
<td>57</td>
<td>Browsing window</td>
<td>41</td>
</tr>
<tr>
<td>58</td>
<td>Report generator</td>
<td>42</td>
</tr>
<tr>
<td>59</td>
<td>Example of weekly report generated in MS-Word</td>
<td>42</td>
</tr>
<tr>
<td>60</td>
<td>Exporting data in Excel</td>
<td>43</td>
</tr>
<tr>
<td>61</td>
<td>Browsing window to choose the measurement to export</td>
<td>43</td>
</tr>
<tr>
<td>62</td>
<td>Exporting data in PQDIF</td>
<td>43</td>
</tr>
<tr>
<td>63</td>
<td>Browsing window to choose the measurement to export</td>
<td>44</td>
</tr>
<tr>
<td>64</td>
<td>Save a file in PQDIF</td>
<td>44</td>
</tr>
<tr>
<td>65</td>
<td>PQDIF export task</td>
<td>44</td>
</tr>
<tr>
<td>66</td>
<td>MAP architecture in server configuration</td>
<td>45</td>
</tr>
<tr>
<td>67</td>
<td>Additional buttons for server side applications</td>
<td>45</td>
</tr>
<tr>
<td>68</td>
<td>Start of CADac Monitor</td>
<td>46</td>
</tr>
<tr>
<td>69</td>
<td>CADac connection and settings</td>
<td>47</td>
</tr>
<tr>
<td>70</td>
<td>Launching the scheduler</td>
<td>47</td>
</tr>
<tr>
<td>71</td>
<td>Add a schema</td>
<td>49</td>
</tr>
<tr>
<td>72</td>
<td>CADac log</td>
<td>50</td>
</tr>
<tr>
<td>73</td>
<td>Detailed information log on selected equipment</td>
<td>50</td>
</tr>
<tr>
<td>74</td>
<td>Maintenance window</td>
<td>51</td>
</tr>
<tr>
<td>75</td>
<td>E.Qual Email</td>
<td>51</td>
</tr>
<tr>
<td>76</td>
<td>E.Qual Email configuration window</td>
<td>52</td>
</tr>
<tr>
<td>77</td>
<td>Evénements/Statistiques</td>
<td>52</td>
</tr>
<tr>
<td>78</td>
<td>Event log + Impact graph</td>
<td>53</td>
</tr>
<tr>
<td>79</td>
<td>Event analysis</td>
<td>54</td>
</tr>
<tr>
<td>80</td>
<td>Menu Events/Statistics</td>
<td>54</td>
</tr>
<tr>
<td>81</td>
<td>ITIC</td>
<td>55</td>
</tr>
<tr>
<td>82</td>
<td>UNIPEDE</td>
<td>56</td>
</tr>
<tr>
<td>83</td>
<td>SEMI F47</td>
<td>56</td>
</tr>
<tr>
<td>84</td>
<td>Device status</td>
<td>57</td>
</tr>
<tr>
<td>85</td>
<td>Long-time data</td>
<td>57</td>
</tr>
<tr>
<td>86</td>
<td>Mise à jour des équipements</td>
<td>58</td>
</tr>
<tr>
<td>87</td>
<td>Drag the parameter</td>
<td>58</td>
</tr>
<tr>
<td>88</td>
<td>Drop the parameter</td>
<td>59</td>
</tr>
<tr>
<td>89</td>
<td>Trend display</td>
<td>59</td>
</tr>
<tr>
<td>90</td>
<td>Simultaneous display</td>
<td>60</td>
</tr>
<tr>
<td>91</td>
<td>Displaying a group in the same graph (a)</td>
<td>60</td>
</tr>
<tr>
<td>92</td>
<td>Displaying a group in the same graph (b)</td>
<td>61</td>
</tr>
</tbody>
</table>